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INDIVIIDIDE VAHELINE ADITIIVGENEETILINE SUGULUS 

1  SUGULUSKOEFITSIENTIDE OLEMUS 

1.1 Sissejuhatus 

Meeldib see meile või mitte, aga sugulased on omavahel sageli teatud määral sarnased. Üks loomulik 

põhjendus sellisele fenotüübilisele sarnasusele on muidugi sugulaste sarnasemad genotüübid
1
. Et vane-

mailt järglastele päranduvad vaid üksikalleelid, siis saab ka sarnasus väljenduda eelkõige üksikute 

alleelide summaarse e aditiivse efekti näol, mistõttu mõistetakse indiviididevahelise geneetilise sarna-

suse all enamasti just nende aditiivgeneetilist sugulust
2
. 

Kahe indiviidi mingid geenid (alleelid) võivad olla identsed kahel põhjusel: esiteks võib tegu olla liht-

salt juhusliku samasusega (no palju seal populatsioonis ikka neid erinevaid alleele esineb – näiteks 

kahe juhuslikult valitud inimese DNA erineb keskmiselt vaid 0,2% ulatuses) ja teiseks võib tegu olla 

ühiselt eellaselt ühes tükis pärandunud nukleotiidide järjestusega. Geneetikas tehakse neil kahel 

põhjusel rangelt vahet. 

Alleele, mis on oma keemiliselt olemuselt identsed, aga mis ei ei pruugi olla sama eellasalleeli 

koopiad, nimetatakse olemuselt identseteks (identical-by-state – IBS). 

Alleele, mis on ühise eellase ühe konkreetse alleeli keemilised koopiad, nimetatakse päritolult 

identseteks (identical-by-descent – IBD). 

 

Näide 1. Olgu kolmes perekonnas (isa, ema ja 2 last), kus eelaste kohta midagi teada ei 
ole, genotüüp määratud ühe markerlookuse osas. Alleelid vaadeldavas lookuses on 
tähistatud numbritega 1, 2 ja 3 ning perekonnad (a), (b) ja (c). Päritolult identsete (IBD) 
ja olemuselt identsete (IBS) alleelide arvud on toodud iga perekonna all. 
 

Perekonna (a) puhul on mõlema haplotüübi pärandumine üheselt tuvastatav – alleel 3 
järglaste genotüübis saab olla pärit vaid emalt, mistõttu peab alleel 1 mõlemal järglasel 
olema saadud isalt, ning kokkuvõttes seega IBS=IBD=2. 

Perekonna (b) puhul on samuti haplotüüpide pärandumine üheselt tuvastatav, Mõlemal 
järglasel on üks olemuselt identne alleel (1), aga et see alleel on saadud erinevatel 
vanematelt, kes eeldatakse suguluses mitteolevaiks, siis IBD=0. 

Perekonnas (c) on mõlemad järglased uuritud lookuse suhtes geneetiliselt identsed, st 

IBS=2, samas ei ole aga võimalik tuvastada alleelide täpset pärandumist, st et võrdse 

tõenäosusega (Mendeli seaduste kohaselt) jagavad kaks järglast kas kahte või mitte ühtegi 

päritolult identset alleeli. 

 

Toodud definitsioonidest järeldub, et kõik IBD-alleelid on ka IBS, aga mitte vastupidi. Genotüüpide 

sarnasuse defineerimisel võetakse aluseks just päritolult identsed alleelid. Viimaste esinemis-

tõenäosused on leitavad klassikaliste tõenäosusteooria seaduspärade kohaselt, tuginedes teadaolevatele 

põlvnemisseostele ning eeldades Mendeli pärandumisseaduste kehtimist. 

                                                 
1
 Lisaks elavad sugulased suurema tõenäosusega sarnastes keskkonnatingimustes, neil võib olla sama 

kultuuriline taust jne. 
2
 Lähisugulaste puhul on võimalik nende sugulust lisaks üksikute geenide summaarsele toimele kirjeldada ka 

geenide koosmõju (dominantsi- ja epistaasiefektid) kaudu, aga et taolised geenide interaktsioonid ei leia oma 
teisejärgulise mõju ja kommertsrakendustega (jõudluskontroll jmt) raskesti inkorporeeritavuse tõttu väljaspool 
teadusuuringuid laialdast kasutust, on need välja jäetud ka käesolevast konspektist. 

 (a) (b) (c) 

1|2 1|3  1|2 1|3  1|2 1|2 

              
 

 

              
1|3 1|3  1|2 1|3  1|2 1|2 

  IBS=2      IBS=1     IBS=2 

  IBD=2      IBD=0     IBD=0 või 2 
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1.2 Malécot’i  suguluskoefitsient 

Olgu tõenäosus, et alleelid Ai ja Aj on päritolult identsed, P( )i jA A . Siis on indiviidide X ja Y 
(genotüüpidega mingis juhuslikult valitud lookuses vastavalt AiAj ning Ai’Aj’) vahelist sugulust 
kirjeldav suguluskoefitsient esitatav seosena

3
 

 
1

' ' ' '4

P(2 juhuslikult valitud alleeli on IBD)

[P( ) P( ) P( ) P( )].

XY

i i i j j i j j

f

A A A A A A A A
 (1) 

Et tegu on juhuslikult valitud lookusega ja alleelidega, siis iseloomustab seosega 

(1) defineeritud päritolult identsete alleelide proportsioon kogu võrreldavate 

indiviidide genotüüpi. Selle koefitsiendi võttis nime coefficient de parenté all 

1948. aastal kasutusele prantsuse statistik G. Malécot; tänapäeval on enam 

levinud ingliskeelsed nimetused coancestry, coefficient of kinship või coefficient 

of consanguinity.  

 

Näide 2. Kui indiviidid X ja Y on omavahel suguluses mitteolevate 
vanemate täisõvedest järglased, on nende iga kahe alleeli päritolult identsuse (samalt 
vanemalt pärandumise) tõenäosus ¼ ja Malécot’i suguluskoefitsient XYf  avaldub 
sõltumatute sündmuste tõenäosuste summana: 

1 1 1 1 1 1
4 4 4 4 4 4( )XYf . 

Iga indiviidi, kelle vanemad ei ole omavahel sugulased, Malécot’i suguluskoefitsient 

iseendaga on ½: 

1
4

1 1
4 2

[P( ) P( ) P( ) P( )]

(1 0 0 1) .

XX i i i j j i j jf A A A A A A A A
 

 

1.3 Aditiivgeneetilise suguluse kordaja, Wright’i suguluskoefitsient 

Malécot’i suguluskoefitsiendi puuduseks on tema pisut segadusseajavad väärtused intuitiivselt 

tajutavate sugulussidemete korral – näiteks eelnevas näites tuletatud sugulus iseenesega on ½ või 

sugulus vanema ja järglase vahel ¼ (kuigi kõik teavad, et järglane saab oma vanemailt pooled 

geenidest). Põhjus on siin selles, et Malécot’i suguluskoefitsient on defineeritud vaid ühe alleeli tarvis. 

Et tegelikult on organismis igast geenist kaks koopiat, siis on nende summaarse mõju uurimisel 

otstarbekas kasutada nn aditiivgeneetilise suguluse (additive genetic relationship) kordajat, mida 

sageli tuntakse lihtsalt nime suguluskoefitsient all (näiteks ka R. Teinbergi raamatus „Põllumajandus-

loomade geneetika”, lk 231), mis mõõdab ühiste geenide osakaalu kahe indiviidi genotüübis ja mis 

võrdub kahekordse Malécot’i suguluskoefitsiendiga: 

 2XY XYa f . (2) 

Aditiivgeneetilise suguluse kordajaga samu väärtusi omandava kordajani jõudis 

juba 1922. aastal USA geneetik Sewall Wright, mõõtes indiviidide 

genotüüpide suhtelist sarnasust vanematelt päritud gameetide vahelise 

korralatsiooni kujul ja nimetades oma kordajat coefficient of relationship (siit 

ka eesti keeles sageli kasutatav nimetus suguluskoefitsient). 

 

Näide 3. Kui indiviidid X ja Y on omavahel suguluses mitteolevate 
vanemate täisõvedest järglased, on nende vaheline Malécot’i 
suguluskoefitsient 1

4XYf  (näide 4.2) ja aditiivgeneetiline sugulus seega 1
2XYa . 

Et iga indiviidi, kelle vanemad ei ole omavahel sugulased, suguluskoefitsient iseendaga 
on ½, siis järelikult aditiivgeneetiline sugulus iseendaga 1XXa . 

 

                                                 
3
 Matemaatiliselt tuleneb valem (1) täistõenäosuse valemist: 

,

P(2 juhuslikult valitud alleeli on IBD)

P( | juhuslikult valitud alleelid on  ja ) P(juhuslikult valiti alleelid  ja )i j i j i ji j A A A A A A
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1.4 Inbriidingukoefitsient 

Sõltumatute sündmuste tõenäosuste lineaarkombinatsioonina avaldunud suguluskoefitsientide 
arvutamine muutub keerulisemaks sugulasaretuse korral. Viimane tähendab omavahel suguluses 
olevate indiviidide ristamist, toob kaasa homosügootsuse suurenemise ja tingib selle, et uuritava 
indiviidi samas lookuses paiknevate alleelide Ai ja Aj päritolult identsuse tõenäosus ei pruugi enam 
võrduda nulliga, P( ) 0i jA A . 

Sugulasaretuse osa indiviidi X genotüübis peegeldab inbriidingukoefitsient XF , mis on defineeritud 
kui tõenäosus, et indiviidi juhuslikult valitud lookuses paiknevad alleelid Ai ja Aj on identsed 
päritolult: 

P( )X i jF A A . 

Uurime järgnevalt näiteks, kuidas muutub vanema ja järglase vaheline sugulus, kui vanema 

inbriidingukoefitsient on nullist suurem. 

Võtame vaatluse alla vanema X, alleelidega uuritavas lookuses Ai ja Aj, ning 

järglase O, alleelidega uuritavas lookuses Ak ja Al.  

On selge, et üks alleelidest Ak või Al peab olema identne kas alleeliga Ai või 

alleeliga Aj. Eeldades, et vanemindiviidi alleelid Ai ja Aj on erinevad, avaldub 

vanema ning järglase vaheline Malécot’i suguluskoefitsient vastavalt valemile 

(1) kujul: 

 
P( ) P( ) P( ) P( ) 1

4 4

i k i l j k j l
XO

A A A A A A A A
f , (3) 

sest murru lugejas olevaist tõenäosustest saab vaid üks olla võrdne 1-ga ning kõik ülejäänud kolm 

võrduvad 0-ga.  

Samas on siiski võimalik, et  

 P( ) 0i j XA A F , (4) 

st, et indiviidi X emal ja isal on ühine eellane, kelle sama alleeli koopiad võivad olla nii alleel Ai kui ka 

alleel Aj.  

Oletame konkreetsuse mõttes, et järglasele on vanemalt pärandunud alleel Ai nii, et P( ) 1i kA A . 
Tänu seosele (4) kehtib siis ka seos P( )j k XA A F , mistõttu on vanema ja järglase vahelise sugulus-
koefitsiendi arvutamise valem (3), arvestades vanema võimalikku inbriidingut, ümber kirjutatav kujul 

1 1
4 4

1 0 0

[P( ) P( ) P( ) P( )] (1 )

X

XO i k i l j k j l X

F

f A A A A A A A A F . 

Analoogse tulemuse saame ka, eeldades alleeli Ak asemel alleeli Al pärandumist. 

Vanema ja järglase vaheline aditiivgeneetiline sugulus on tänu seosele (2) leitav valemist  

1
2 (1 )XO Xa F . 

 

2  WRIGHT’I RAJAKOEFITSIENTIDE MEETOD 
SUGULUSKOEFITSIENTIDE LEIDMISEKS 

Eelmise punkti lõpetanud tuletuskäiguga sarnase arutelu tulemusena on võimalik leida ka üldisemad 
suguluskoefitsientide seaduspärad, mis baseeruvad kõigi suguluses olevate indiviidide vaheliste teede 
(radade, inglise keeles path) läbikäimisel sugupuus ja millised esmakordselt tuletas Sewall Wright (siit 
ka meetodi nimetus – Wright’i rajakoefitsientide meetod). 

Võtame näiteks vaatluse alla indiviidid X ja Y, kellel on ühine mitmete põlvkondade tagune eellane W. 
Kuna me oleme huvitatud vaid päritolult identsetest alleelidest, peame 
indiviidide X ja Y vahelise suguluse tuvastamiseks võtma vaatluse alla 
tee X–...–W–…–Y (kui sama alleeli võimaliku pärandumise raja). 

Kui indiviid W on X-i ja Y-i vanem (X ja Y on poolõved) ning 0WF , 
siis  

1 1 1 1 1 1
4 8 8 8 8 8

P( ) P( ) P( ) P( )

( )
k k k l l k l l

XY

A A A A A A A A

f  

ja 1
4XYa . Kui aga 0WF , siis 

X 

(AiAj) 
 

O 

(AkAl) 

 

W 

(AiAj) 

Y 

(Ak’Al’) 
 

X 

(AkAl) 
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O 

X Y 

W Z 

Ö Ü 

Ä Õ 

1 1 1 1 1 1 1 1 1 1
4 8 8 8 8 8 8 8 8 8

P( ) P( ) P( ) P( )

( ) (1 )

k k k l l k l l

XY W W W W W

A A A A A A A A

f F F F F F . 

Kui indiviidi W näol on tegu varasema eellasega, siis tuleb suguluskoefitsienti korrutada ½-ga iga 
täiendava indiviidide X ja W või Y ja W vahelise generatsiooni kohta, sest iga generatsiooniga väheneb 
sama alleeli pärimise tõenäosus ½ korda. Näiteks kui indiviid W on indiviidi X vanem, aga indiviidi Y 
vanavanem, siis 1 1

2 8[ (1 )]XY Wf F . 

Üldkujul avaldub suguluskoefitsient järgmiselt: 
11 1 1

2 2 2[( ) (1 )] ( ) (1 )n m n m
XY W Wf F F , 

ning aditiivgeneetilise suguluse kordaja on 

1
2 (1 )

n m
XY Wa F , 

kus n ja m tähistavad vastavalt indiviidide X ja W ning Y ja W vahelist kaugust. 

Kuna erinevaid radu indiviididest X ja Y ühise eellaseni W võib olla mitmeid, tuleb kõik need ühise 

alleeli edasikandumisvõimalused suguluskoefitsientide arvutamisel arvesse võtta. Tulemuseks on 

summa üle kõigi radade ühise eellaseni: 

1
2

1

(1 )
j j

k n m
XY W

j

a F , 

kus k tähistab erinevate radade arvu ning nj ja mj tähistavad vastavalt indiviidide X ja W ning Y ja W 

vahelist generatsioonide arvu läbi j. raja. 

Kui ühiseid eellasi on mitu, on vajalik summeerimine üle nende kõigi: 

, ,1
2

1 1

(1 )
i

i j i j

i

l k n m
XY W

i j

a F , (5) 

kus l tähistab ühiste eellaste arvu, ki erinevate radade arvu indiviididest X 
ja Y ühise i. eellaseni Wi, ,i jn  ja ,i jm  tähistavad vastavalt indiviidide X ja 
Wi ning Y ja Wi vahelist generatsioonide arvu läbi j. raja ning iWF  on i. 

ühise eellase Wi inbriidingukoefitsient. 
 

Sarnase tõenäosusliku lähenemisega on võimalik seostada indiviidi inbriidingukoefitsient tema vane-
mate suguluskoefitsiendiga ning seeläbi tuletada üldine valem inbriidingu-
koefitsiendi leidmiseks. 

Oletame, et indiviidi O vanemate X ja Y genotüübid mingis juhuslikult valitud 
lookuses on vastavalt AiAj ning Ai’Aj’ ning vanemate vaheline suguluskoefitsient 
on fXY, vt (1). Siis on järglase inbriidingukoefitsient (tõenäosus, et vanemate 
juhuslikult valitud gameedid, mis moodustavad järglase genotüübi, sisaldavad 
vaatlusaluses lookuses päritolult identseid alleelele) võrdne tema vanemate 
suguluskoefitsiendiga: 

1
' ' ' '4P( ) [P( ) P( ) P( ) P( )] .O k l i i i j j i j j XYF A A A A A A A A A A f  

Seega on järglase inbriidingukoefitsient võrdne poolega tema vanemate aditiivgeneetilise suguluse 

kordajast: 

 1
2O XY XYF f a , (6) 

mis valemi (5) kaudu on esitatav kujul 

 
, ,1 1 1

2 2 2
1 1

(1 )
i

i j i j

i

l k n m
O XY W

i j

F a F . (7) 

 

Näide 4. Leiame kõrval toodud põlvnemisskeemist indiviidi 

O inbriidingukoefitsiendi.  

Indiviidi O vanemad X ja Y omavad ühiseid esivanemaid W ja 
Z, viimastest W on omakorda saadud sugulusaretuse tulemu-
sel. Vastavalt valemile (7) tuleb OF  arvutamisel leida pärit-
olult identsete alleelide tõenäosus kahest põlvnemisteest 
lähtudes ja saadud tulemused liita: 

W1 

Y X 

W2 

Wl 
... 

X 

(AiAj) 

Y 

(Ai’Aj’) 

 

O 

(AkAl) 
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C D 

F 

I 

M 

H 

K 

G 

E 

Aahotep I 
Sekvenenra II 

Ahmos I 

Ahmos-

Nefertari 

Thutmosis I 

Hatšepsut 

Amenhotep I 

A B 
Sekvenenra I 

Tetišeri 

Mutneferti 

L 

Thutmosis II 

P 
Neferura 

Joonis 1. Osa Egiptuse vaaraode 18. dünas-
tia sugupuu algusest. 

N 

O Thutmosis III 

Isis 

Ahmos II J 

Senseneb 

1 1 1 11 1 1
2 2 2

rada rada

[ (1 ) (1 )]O W Z

X Y X Y

F F F

W Z

. 

Et 0ZF  ja 

1 1 1 11 1 1 1 1
2 2 2 2 2

00

[ (1 ) (1 )] 0,25W ÄÕF F F  

(vaikimisi eeldame, et indiviidid Õ, Ä ja Z pole omavahel suguluses), siis  

51 1 1
2 4 4 4( 1) 9 32 0,28125OF . 

Suguluskoefitsiendi leidmise näitena uurime indiviidide X ja O vahelist aditiivgeneetilist 
sugulust. Et indiviididel X ja O on kaks ühist eellast – W ja Z, ning lisaks on indiviid X 
indiviidi O vanemaks, siis avaldub nendevaheline aditiivgeneetiline sugulus kolme 
liidetava summana: 

0 1 1 2 1 21 1 1
2 2 2

rada rada rada

(1 ) (1 ) (1 )XO X W Z

X O X Y O X Y O

a F F F

X W Z

. 

Et  0X WZF f , 1
4WF  ja 0ZF  siis 

51 1 1
2 8 4 81 1 25 32 0,78125XOa . 

 

Keerulisemate põlvnemisskeemide puhul on sugulus- ja inbriidingukoefitsientide arvutamisel Wright’i 

rajakoefitsientide meetodil mõttekas esitada arvutused tabelina, kus on kirjas kõik võimalikud 

mittekattuvad rajad ühise eellaseni ja neile vastavad liidetavad koefitsiendi arvutusvalemis. 

 

Näide 5. Joonisel 1 on kujutatud osa Egiptuse Uuele riigile aluse pannud vaaraode 18. dü-
nastia (1552 e.m.a.) sugupuust. Leiame ku-
ninganna Hatšepsuti ja vaarao Thutmosis II 
tütre Neferura inbriidingukoefitsiendi, jättes 
arvesse võtmata vaarao Thutmosis I spekula-
tiivse pärinemise (joonisel katkendlikud joo-
ned). 

Koondame arvutused alljärgnevasse 
tabelisse.  
 

Tee nij + mij Fi FP liidetav 

LKM 2 0 
31

2( )  

LHEIM 4 FE = ¼ 
51 1

2 4( ) (1 )  

LHFIM 4 FF = ¼ 
51 1

2 4( ) (1 )  

LHECFIM 6 0 
71

2( )  

LHFCEIM 6 0 
71

2( )  

LHFDEIM 6 0 
71

2( )  

LHEDFIM 6 0 
71

2( )  

LHECADFIM 8 0 
91

2( )  

LHEDACFIM 8 0 
91

2( )  

LHFCADEIM 8 0 
91

2( )  

LHFDACEIM 8 0 
91

2( )  

LHECBDFIM 8 0 
91

2( )  

LHEDBCFIM 8 0 
91

2( )  

LHFCBDEIM 8 0 
91

2( )  

LHFDBCEIM 8 0 
91

2( )  

 

3 5 7 9 5 161 1 1 1 1 1 1 1
2 2 4 2 2 8 64 32 64 64( ) 2 ( ) (1 ) 4 ( ) 8 ( ) 0,25 .PF  
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C 

J 

M 

H 

K 

G 

E 

A B 

L 

Z 

X Y 

D 

Kui alleelide pärimisteed lõikuvad (lõikepunktis on ühine eellane), siis tuleb trajektoor sellest ühisest 
eellasest ettepoole (ülespoole) arvestusest välja jätta. 

 

Näide 6. Analüüsime põlvnemispuud kõrvaloleval joonisel, leides 

indiviidi Z inbriidingukoefitsiendi. Indiviidi Z vanemate, X ja Y, 

ühised eellased on A, B, C ja H (on ka D, aga põlvnemistee temani 

kulgeb nii X-i kui ka Y-i puhul läbi ühise eellase H, mistõttu 

alleelide põlvnemine seda teed mööda on juba arvesse võetud). 

Koondame arvutused alljärgnevasse tabelisse. 

 

Tee nij + mij Fi FZ liidetav 

XKHLY 4 FH =
1
/8 

51 1
2 8( ) (1 )  

XKGCHLY 6 0 
71

2( )  

XKHDBELY 7 0 
81

2( )  

XKHDBEJMY 8 0 
91

2( )  

XKGCADHLY 8 0 
91

2( )  
 

5 7 8 9 131 1 1 1 1
2 8 2 2 2 256( ) (1 ) ( ) ( ) 2 ( ) 0,05078 .ZF  

 

 

3  HENDERSONI MEETOD SUGULUSKOEFITSIENTIDE LEIDMISEKS 

Nagu viimasest näitest näha, on Wright’i meetodi rakendamine vähegi 

keerulisemate  põlvnemisskeemide korral komplitseeritud. USA farmer, geneetik, 

statistik ning suure hulga XX sajandil aretusteooriat olulisel määral modifitseerinud 

teadlaste juhendaja nende ülikooli päevil,  Charles Roy Henderson, tuletas 1953. 

aastal meetodi, mis ei lähe mööda sugupuud tagasi kõige kaugemate eellasteni nagu 

Wright’i meetod, vaid hoopis alustab neist ja liigub ajas edasi kõige nooremate 

indiviidideni. 

Hendersoni meetod baseerub kahel lihtsal seaduspäral. 

Esiteks, aditiivgeneetiline sugulus kahe indiviidi, X ja Y, vahel võrdub keskmise 

aditiivgeneetilise sugulusega indiviidi Y vanemate (W ja Z) ja indiviidi X vahel: 

 1
2 ( )XY XW XZa a a . (8) 

Tõestus. Malécot’i suguluskoefitsient indiviidide X ja Y vahel avaldub kujul 

1 1
' ' ' '2 2

1
4

[P( ) P( ) P( ) P( )] [P( ) P( ) P( ) P( )]

1 1
2 4

1
4

[ P( ) P( ) P( ) P( ) ]

{ [P( ) P( ) P( ) P( )]

[P(

m i m j m i m j n i n j n i n j

XY m k m l n k n l

A A A A A A A A A A A A A A A A

m i m j n i n j

m

f A A A A A A A A

A A A A A A A A

A A ' ' ' '

1
2

) P( ) P( ) P( )]}

( ),

i m j n i n j

XW XZ

A A A A A A

f f

 

millest tänu seosele (2) järeldub valem (8).■ 

Teiseks, indiviidi Y inbriidingukoefitsient võrdub poolega tema vanemate vahelisest aditiiv-

geneetilisest sugulusest (vt valem (6)) ning indiviidi aditiivgeneetiline sugulus iseendaga on  

 1
21 1YY Y WZa F a . (9) 

Tõestus. Et  

1 1 1
4 4 2[P( ) P( ) P( ) P( )] (1 1) (1 ),YY k k k l l k l l Y Y Yf A A A A A A A A F F F  

siis valemeist (2) ja (6) järeldub seos (9).■ 

 

Hendersoni meetod indiviidide suguluskoefitsientide leidmiseks koosneb järgmistest sammudest: 

1. Indiviidid järjestatakse genealoogiliselt, st vanemad paiknevad enne järglasi. 

W 
(AiAj) 

Z 
(Ai’Aj’) 

 

Y 
(AkAl) 

 

X 
(AmAn

) 
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2. Konstrueeritakse tabel, kus igale indiviidile vastab üks rida ja üks veerg nii, et vanimale vastab 
esimene rida/veerg ja noorimale viimane rida/veerg. 

3. Tabeli täitmist alustatakse ülemisest vasakust nurgast (vanimast indiviidist) – sedasi garan-
teeritakse, et mingi aditiivgeneetilise suguluskordaja avaldamiseks vajalikud vanemate indiviidide 
vahelised seosed on juba teada ja tabelist lihtsalt mahakirjutatavad. 

4. Kui parajasti vaatluse all oleva indiviidi vanemad ei ole teada, siis kirjutatakse temale vastavasse 
tabeli diagonaalil paiknevasse lahtrisse 1 (aditiivgeneetiline sugulus iseendaga on 1) ja täidetakse 
vastava rea ja veeru lahtrid kuni diagonaalil paikneva lahtrini 0-dega (aditiivgeneetiline sugulus 
põlvnemisskeemis eespool paiknevate indiviididega on 0). Loomakasvatusteaduses nimetatakse 
taolisi loomi, kelle eellaste kohta info puudub, sageli baasloomadeks (base animals). 

5. Kui vaatluse all oleva indiviidi vanem(ad) on teada, siis leitakse  

5.1. vastav diagonaalil paikneva lahtri väärtus tuginedes valemile (9) kui üks pluss pool 
vaatlusaluse indiviidi vanemate vahelisest aditiivgeneetilisest sugulusest, ning 

5.2. ülejäänud samas reas ja veerus diagonaallahtrist vastavalt vasakul ja ülal paiknevad väärtused 
tuginedes valemile (8) kui pool vaatlusaluse indiviidi vanemate ja konkreetsele reale/veerule 
vastava indiviidi vahelistest aditiivgeneetilise suguluse kordajatest. Kui üks vaatluse all oleva 
indiviidi vanemaist on teadmata, loetakse teiste põlvnemisskeemis esindatud indiviidide 
aditiivgeneetiline sugulus selle vanemaga võrdseks nulliga. 

6. Tabeli täidetuse järel on iga kahe indiviidi vaheline aditiivgeneetiline sugulus välja loetav neile 
vastavate ridade-veergude ristumiskohas paiknevast lahtrist; iga indiviidi inbriidingukoefitsient on 
valemist (9) avaldatuna leitav, lahutades vastavast diagonaallahtris paiknevast kordajast arvu üks. 

 

Näide 7. Vaatame näites 4 vaatluse all olnud põlvnemisskeemi ja leiame kõigi indiviidide 
inbriidingukoefitsiendid ja aditiivgeneetilise suguluse korda-
jad. 

Järjestame indiviidid Õ-st kuni O-ni genealoogiliselt ja 
konstrueerime tabeli suguluskordajate tarvis. 

Indiviidid Õ ja Ä on nö baasloomad, kes eeldatakse olevat 
mittesugulased ja kellele vastavatesse tabeli peadiagonaalil 
paiknevatesse lahtritesse kirjutame 1 ( 1ÕÕa  ja 1ÄÄa ) 
ning kellevahelist aditiivgeneetilist sugulust kirjeldavatesse 
lahtritesse 0 ( 0ÕÄ ÄÕa a ). 

 

 
 Õ Ä Ö Ü W Z X Y O 

Õ 1 0        

Ä 0 1        

Ö          

Ü          

W          

Z          

X          

Y          

O          

 

Järgmisel indiviidil, Ö, on teada nii ema kui ka isa, mistõttu leiame tema aditiiv-
geneetilise suguluse iseendaga valemist (9) ja aditiivgeneetilise suguluse enesest eespool 
paiknevate indiviididega valemist (8): 

1
2

0

1 1ÖÖ ÕÄa a , 1 1
2 2

1 0

( )ÖÕ ÕÕ ÄÕa a a , 1 1
2 2

10

( )ÖÄ ÄÄÕÄa a a . 

Analoogselt avalduvad indiviidi Ü suguluskordajad iseenese ja oma vanematega. 

Indiviidide Ü ja Ö vahelise aditiivgeneetilise suguluskordaja avaldame valemist (8): 
1 1

2 2

1 21 2

( )ÖÜ ÜÖ ÖÄÖÕa a a a . 

 

O 

X Y 

W Z 

Ö Ü 

Ä Õ 
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 Õ Ä Ö Ü W Z X Y O 

Õ 1 0 ½ ½      

Ä 0 1 ½ ½      

Ö ½ ½ 1 ½      

Ü ½ ½ ½ 1      

W          

Z          

X          

Y          

O          

Analoogselt jätkates (näiteks 11
2 4

1 2

1 1WW ÖÜa a , 1 1
2 2

1 2 1 2

( )WÕ ÖÕ ÜÕa a a , …) saame 

ära täita kogu tabeli. 

 Õ Ä Ö Ü W Z X Y O 

Õ 1 0 ½ ½ ½ 0 ¼ ¼ ¼ 

Ä 0 1 ½ ½ ½ 0 ¼ ¼ ¼ 

Ö ½ ½ 1 ½ ¾ 0 ⅜ ⅜ ⅜ 

Ü ½ ½ ½ 1 ¾ 0 ⅜ ⅜ ⅜ 

W ½ ½ ¾ ¾ 1¼ 0 ⅝ ⅝ ⅝ 

Z 0 0 0 0 0 1 ½ ½ ½ 

X ¼ ¼ ⅜ ⅜ ⅝ ½ 1 9
16  

25
32  

Y ¼ ¼ ⅜ ⅜ ⅝ ½ 9
16

 
1 25

32  

O ¼ ¼ ⅜ ⅜ ⅝ ½ 25
32  

25
32  9

321  

Tabelist saab välja lugeda näiteks, et 9 9
32 321 1 0,28125OF , või et 

25
32 0,78125XOa  (samad tulemused saime ka näites 4). 

 

4  PÕLVNEMISANDMETE HALDAMISE JA ANALÜÜSIMISE TARKVARA 
Pedigree Viewer 

Internetis leidub mitmeid raha eest või suisa tasuta allalaaditavaid põlvnemisandmete haldamiseks, 
graafiliseks esitamiseks ja analüüsimiseks mõeldud arvutiprogramme. Ühe eelkõige loomade aretust 
silmas pidava programmi (mis siiski on rakendatav ka teiste eluvormide põlvnemisandmetel) kirjutas 
Austraalias töötav kvantitatiivse geneetika professor Brian Kinghorn. See programm, mis kannab nime 
Pedigree Viewer ja on tasuta allalaaditav aadressilt 

http://www-personal.une.edu.au/~bkinghor/pedigree.htm, 
võimaldab väga mitmekülgselt hallata ja ekraanil esitada nii suuri kui ka väikeseid sugupuid, arvutada 
nii inbriidingu- kui ka suguluskoefitsiente ja hinnata dispersioonanalüüsi segamudelite abil aretus-
väärtuseid. Programmi uus versioon pakub lisaks võimalusi paaride valikuks. Programmiga kaasneb 
lühike ja küllalt selge abifail (Joonis 2) ja mitmed näiteandmestikud, mille abil programmi 
võimalustega iseseisvalt tutvuda. 

Programmi tööks vajalik tabel peab kindlasti sisaldama kolme veergu järjekorras: 

’Indiviid’ | ’Isa’ | ’Ema’, 

millele võivad järgneda veel täiendavad uuritavaid indiviide iseloomustavad näitajad (sugu, vanus, 
pikkus jne). Indiviidid, isad ja emad peavad olema üheselt identifitseeritavad kas siis nime, numbri või 
mingi koodi alusel. Ridade (indiviidide) järjekord andmetabelis on vaba, genealoogiline järjestus ei ole 
vajalik, selle paneb paika Pedigree Viewer ise. Pedigree Viewer’is avatav andmetabel peab enesest 
kujutama fikseeritud veergude eraldajaga (koma, tühik jne) tekstifaili, milles kümnendkohtade 
eraldajana on kasutatud punkti ja mille nime laiend peab olema ’ped’, ’txt’ või ’dat’ – näiteks sobib 
Excel’is tekstifailina salvestatud andmetabel. Ka programmi töö tulemusena modifitseeritud 
(genealoogiliselt järjestatud, inbriidingukoefitsientidega ja/või aretusväärtustega täiendatud) sugupuu 
on salvestav analoogse tekstifailina (ja on soovikorral avatav näiteks Excel’is). 

http://www-personal.une.edu.au/~bkinghor/pedigree.htm
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Joonis 2. Programmi Pedigree Viewer abifail. 

 

Teadmata emade ja isade tähisena kasutab Pedigree Viewer vaikimisi arvu 0, muude tunnuste 
(fenotüübiväärtused jmt) korral on teadmata väärtuste vaikimisi tähiseks -999999 (Joonis 3 [a]). 
Enamasti on aktsepteeritav ka teadmata väärtustele vastavate lahtrite lihtsalt tühjaks jätmine (Joonis 3 
[b]), aga taoliselt vormindatud ja samas veergude eraldajana samuti tühikuid kasutavate andmetabelite 
Pedigree Viewer’isse sisselugemine võib lõppeda veateatega ... 

 

       [a]        [b] 

Joonis 3. Andmetabeli vormindamine Pedigree Viewer’i tarvis. 

 

Indiviide, kelle mõlemad vanemad on teadmata ja kelle kohta ei ole teada ka fenotüübiväärtusi 

(loomad 1 ja 5 joonisel 3 toodud tabeleis), ei ole vaja algandmeis eraldi ridadesse kirjutada, Pedigree 

Viewer tekitab üksnes isana või emana esinevatele indiviidele (baasloomadele) vastavad read tabelisse 

ise. 

 

Pedigree Viewer järjestab avatavas andmetabelis sisalduvad indiviidid genealoogiliselt
4
, jagab nad 

generatsioonidesse ja kujutab sugupuud skemaatiliselt (Joonis 4). 

 

Lühikokkuvõte nii kogu sugupuu kui ka üksikute generatsioonide kohta on tellitav menüüst View -> 
Statistics. 

Suurte sugupuude korral sageli esineda võivate vigade (sama loom esineb sugupuus mitu korda ja 
seejuures erineva(te) vanema(te)ga või esineb mõni loom nii isade kui ka emade veerus) 
kontrollimiseks on menüüs Tools käsud Check for dublicate IDs ja Check for bisexuality. 

 

 

                                                 
4
 vanemad paiknevad eespool järglasi 
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Joonis 4. Programmi Pedigree Viewer ekraanipilt. 

 

Menüürea all paikneva nupurea (Joonis 5) abil on võimalik muuta sugupuu paigutust ekraanil, 
värvipaletti (teksti, joonte ja tausta värvi, ja seda eraldi ekraanil kuvamiseks ja välja trükkimiseks), 
teksti fondi suurust ning vanemaid ja järglasi ühendavate joonte kuju ( ).  

 

Joonis 5. Programmi Pedigree Viewer nupuriba. 

 

Üksiku indiviidi ja tema sugulaste selekteerimiseks sugupuust on lihtsaim viis klikkida hiire 

parempoolse klahviga soovitul (kuvatakse valitud indiviid koos ühe põlvkonna vanemate ja 

järglastega). Kombineerides omavahel klaviatuuri klahve ’Ctrl’, ’Shift’ ja ’Alt’ ning hiire parem- ja 

vasakpoolset klahvi, on võimalik ekraanil kuvada ühe või mitme indiviidi erineva taseme sugulasi. 

Selekteeritud indiviidi vanemate, järglaste või erineva taseme sugulaste kuvamiseks vajalikud käsud 

on valitavad ka menüüst View -> Relatives (Joonis 6). 

 

 

Joonis 6. Selekteeritud looma(de) erineva taseme sugulaste kuvamine menüükäskude abil. 



Indiviidide vaheline aditiivgeneetiline sugulus 

 12 

Suurte sugupuude puhul, kui andmeid on konkreetse indiviidi hiirega klikkides valimiseks liiga palju, 

on alternatiivina võimalik sisse lülitada funktsioon, mis tõstab esile parajasti hiire kursoriga üle 

libistatava indiviidi nime või koodi (Tools -> Highlight target). 

 

Lisaks on võimalik lasta ka programmil enesel üles otsida teatud tingimusi rahuldavad indiviidid 

(Tools -> Find või nupp , vt Joonis 7).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Joonis 7. Huvipakkuvate (konkreetse nimega, sünniaastaga, sooga, inbriidingukoefitsiendi väärtusega jne) 

indiviidide otsimise aken programmis Pedigree Viewer. 

 

 

Võimalik on teatud osa sugupuust suuremana kuvamine (Tools -> Zoom In või ), kogu sugupuu 
uuesti korraga ekraanile mahutamiseks tuleb klõpsata nupul  (või Tools -> Zoom Out). 

 

Samuti võib iga indiviidi juurde lisaks vaikimisi kuvatavale nimele või koodile (või hoopis selle ase-
mel) kirjutada mõne teise andmestikus sisalduva väärtuse (näiteks võib skeemil kuvada iga indiviidi 
juures tema isa või sugu, kui viimane on andmestikus olemas; View -> Display Fields või ). 

 

Väga kasulik on kas siis kogu sugupuu või sellest välja valitud väiksema osa optimeerimise ehk nn 
korrastamise võimalus nupu  abil (Joonis 8). Uuesti kogu sugupuu ekraanil kuvamiseks tuleb 
klõpsata nuppu . 

 

Valmis kujundatud sugupuu või osa sellest on võimalik salvestada pildifailina bmp-formaadis (Fail -> 
Save image of pedigree diagram). 

 

Otsimaks veerust ’Kood’ 

väärtusi ’Poiss’ 

Vaja märkida, kui on soov 

otsida kõiki loomi, kelle ID-

koodis sisaldub väärtus ’Poiss’ 

Tervest sugupuust kuvatakse 

roosa rõngaga märgitult vaid 

selekteeritud loomad koos 

otseste vanemate ja järglastega  

Võimalik on otsida ka 

huvipakkuvasse vahemikku jäävate 

väärtustega indiviide 
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Joonis 8. Esialgne ja korrastatud sugupuu Pedigree Viewer’s. 

 

 

Võttes arvesse kogu sugupuu andmed on võimalik välja arvutada mistahes kahe indiviidi vaheline 
Malécot’i suguluskoefitsient (Tools -> Coancestry; Joonis 9), kõigi indiviidide inbriidingukoefitsien-
did (Tools -> Inbreeding Coefficients) ning aretusväärtused andmestikus sisalduvatele arvulistele 
tunnustele (Tools -> Run BLUP Analysis). 

Nii aretusväärtused kui ka inbriidingukoefitsiendid lisatakse eraldi veergudena sugupuu aluseks ole-
vasse andmetabelisse ning on seeläbi kuvatavad sugupuus ekraanil ( ) ja kasutatavad otsingus ( ). 

NB! Nupul  klikkimise järgselt loeb Pedigree Viewer andmed uuesti sisse algandmete tabelist, 
kaotades sellega ära kord juba leitud inbriidingukoefitsientide väärtused ja aretusväärtuste hinnangud, 
mis tuleb siis vajadusel uuesti leida. 

 

 

Joonis 9. Indiviidide vahelise suguluskoefitsiendi arvutamise aken. 

NB! Pedigree Viewer’i poolt leitav suguluskoefitsient on antud konspektis punktis 1.2 käsitletud Malécot’i 

suguluskoefitsient, aditiivgeneetilise suguluse kordaja võrdub selle kahekordse väärtusega. 

 

 



Indiviidide vaheline aditiivgeneetiline sugulus 

 14 

V 

U 

Q R S 

T 

C D 

F 

I 

M 

H 

K 

G 

E 

Aahotep I 
Sekvenenra II 

Ahmos I 

Ahmos-
Nefertari 

Thutmosis I 

Hatšepsut 

Amenhotep I 

A B 
Sekvenenra I 

Tetišeri 

Mutneferti 

L 

Thutmosis II 

P 
Neferura 

N 

O Thutmosis III 

Isis 

Ahmos II J 

Senseneb 

5  ENESEKONTROLL 

5.1 Ülesanded 

1. Leidke kõrval toodud põlvnemisskeemis looma V inbriidingukoefitsient FV ja loomade V ja T 
vaheline aditiivgeneetilise suguluse kordaja aVT Wright’i 
meetodil. 

2. Leidke kõigi loomade vahelised aditiivgeneetilise suguluse 
kordajad Hendersoni meetodil. 

 

 

 

 

3. Sisestage kõrvalolev Egiptuse vaaraode sugupuu 
arvutisse (võttes arvesse ka vaarao Thutmosis I 
spekulatiivse pärinemise - diagrammil märgitud 
punktiirjoonega) ja avage see programmi Pedigree 
Viewer abil. 

Segaduste vältimiseks on kõik meessoost isikud alla 
joonitud. 

 

Kasutades programmi Pedigree Viewer ning teadmisi 
sugulus- ja inbriidingukoefitsientide vahelistest 
seostest, vastake järgmistele küsimustele. 

 

a) Milliste vaaraode või printsesside 
inbriidingukoefitsent on kõige suurem? Kui suur 
see on? 

b) Kui paljude isikute inbriidingukoefitsient on 0? 
Miks? 

c) Kui suur on vaarao Amenhotep I ja printsessi 
Ahmos II vaheline (Wright'i) suguluskoefitsient? 
Kui suur olnuks nende abiellumisel nende 
järglase inbriidingukoefitsient? 

 

 

5.2 Ülesannete vastused 

1. 1
8 0,125VF ; 5

8 0,625VTa . 

2.  

 
R Q S T U V 

R 1 0 0 ½ 0 ¼ 

Q 0 1 0 ½ ½ ½ 

S 0 0 1 0 ½ ¼ 

T ½ ½ 0 1 ¼ 5
8  

U 0 ½ ½ ¼ 1 5
8  

V 0 ½ ¼ 5
8  5

8  1
81  
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3. Sugupuu kolmeveerulise tabelina peaks välja nägema järgmine: 

 

Sama tabeli Pedigree Viewer'sse sisselugemiseks sobiva tekstifailina võite omale salvestada siit: 

http://ph.emu.ee/~ktanel/sugulus1/vaarao.txt 

Pedigree Viewer's näeb sugupuu välja järgmine (lisaks vaikimisi kuvatavatele nimedele on sellele 

joonisele arvutatud juba ka inbriidingukoefitsiendid): 

 

a) Nagu jooniselt näha, on maksimaalne inbriidingukoefitsiendi väärtus 0,375 ning seda vaaraol 

Amenhotep I ja printsessidel Mutneferti, Ahmos II ja Neferura. 

b) Inbriidingukoefitsiendi väärtus on 0 kaheksal sugupuuse kuuluval isikul. Põhjuseks see, et nende 

korral on teadmata vähemalt üks vanavanemaist. Kui aga vanavanem on teadmata, siis ei ole võimalik 

leida vanemate vahelist suguluskoefitsienti (see võetakse võrdseks nulliga), mistap tuleb null ka 

järglase inbriidingukoefitsient (vt valem (6)). 

c) Vaarao Amenhotep I ja printsessi Ahmos II vaheline (Wright'i) suguluskoefitsient  

aAmenhotep I, Ahmos II = 1 

(Pedigree Viewer'i poolt arvutatav Malécot'i suguluskoefitsient  fAmenhotep I, Ahmos II = 0,5). 

Nende abiellumisel olnuks nende järglase inbriidingukoefitsient 0,5 (sest järglase inbriidingu-

koefitsient on võrdne poolega vanemate vahelisest aditiivgeneetilise suguluse kordajast e Wright'i 

suguluskoefitsiendist). 


